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If you make music on a computer, then 
you’re inevitably going to come across the 
acronym MIDI, standing for Musical 
Instrument Digital Interface.

MIDI is a ‘language’ that computers and 
electronic instruments (such as keyboards, 
drum machines and synthesisers) use to 
communicate. When you play a music keyboard 
and record its MIDI output, you’re not capturing 
the actual sound the instrument makes, but 
rather the performance – a list of what notes 
were played and when, how long they were held 
for, how hard they were pressed and so on. It’s 
only when a MIDI keyboard or recording is 
connected to a sound generator such as a 

synthesiser that any sound will be heard, as the 
synth reads through the performance 
information and outputs sound accordingly.

Of course, if you play a MIDI keyboard 
straight into a synthesiser or, more likely, a 
computer with a virtual synthesiser on it, all this 
will happen pretty much instantly, so it’ll feel like 
you’re playing a real, ‘live’ synth. If you’re 
recording, however, because only playing 
information is recorded, rather than sound, you 
can change the sound after the event by 
sending the MIDI data through whatever sound 
source you like – a synth, a sampler, etc.

What’s more, because the computer stores 
every detail of the performance separately, you 

can delete wrong notes, change chords and 
even alter the timing after the track has been 
recorded, just by clicking on notes and dragging 
them around. This makes MIDI very flexible.

You can think of MIDI like a modern-day 
equivalent of the old player piano – those music 
machines that read sheets of paper with holes 
punched in them. The length and position of the 
holes instructed the player piano as to which 
note to play and how long to hold it for, so these 
rolls were the mechanical predecessor of MIDI – 
in fact, the term ‘piano roll’ is still used in MIDI 
sequencers today to refer to the standard MIDI 
editing window.

So that’s what MIDI is – but how does it work?

It’s one of the most important concepts in computer music, and 
it’s not as scary as you might think – let’s get to grips with MIDI

ON THE DVD

Find the audio and MIDI 
files referenced here in 
the Tutorial Files folder
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During the 70s, the electronic instrument 
market was booming. New synths and 
keyboards were being released left, right and 
centre, and if you were a serious synthesist, 
you’d make sure you had the newest and 
most out-there sounds available. Of course, 
the sounds were, in most cases, physically 
linked to the keyboard of the synth in 
question, and what few formats existed to 
link keyboards and sound modules together 
were non-universal and incredibly unreliable. 

This led to synthesists in bands appearing 
behind walls of keyboards, affording them 
access to all of their sounds but completely 
hiding them from the audience.

In 1981, engineer Dave Smith (who had 
already invented a pioneering synth in the 
Sequential Circuits Prophet 5) proposed a 
new way of linking electronic instruments 
together – a technical specification that all 
manufacturers would follow to enable the 
keyboard of any equipped instrument to 

drive any equipped external sound module. 
In 1984, MIDI was born. In 1985, the Atari ST 
became the first home computer to ship with 
MIDI ports – and early MIDI software 
packages such as Cubase and Notator (now 
Logic) are still going strong today, albeit in 
radically improved forms. Over the years, 
there have been numerous tweaks and 
upgrades made to the MIDI specification, but 
the core of it is still the same after over two 
and a half decades. How’s that for longevity?

A brief history of MIDI

MIDI – the technical details
Before we start using MIDI, let’s take a 
quick look at the details. This is just a 
brief overview of how MIDI works – most 
of the time, all the things we’re about to 

discuss will happen behind the scenes, 
without you having to really worry about 
them. However, it’s still good to have 
some knowledge of what’s going on.

The MIDI ‘language’ that MIDI-capable 
instruments use to communicate is made up 
of MIDI ‘messages’. Every time you play a key 
on your MIDI keyboard or your music 
software reads a MIDI note, a message is 

transmitted. These messages contain 
instructions that tell another MIDI-capable 
device (usually a sound generator, such as a 
synth or sampler plug-in) what to do. 

MIDI messages are the same whether you 

play them on a keyboard or click them into 
the MIDI editor of your DAW software, but 
we’ll look at the keyboard example here, 
as it’s probably the easiest to explain by 
way of illustration…

MIDI event messages

Note On, Note Off

When you play a note on your 
keyboard, it sends a Note On MIDI 
message. This chunk of data 
simply tells whatever your 
keyboard is plugged into (say, for 
example, a synthesiser plug-in on 
your computer) what note was 
pressed and how hard it was 
played (known as Velocity – see 
the next column, right). When 
you let go of the key (whether 
after five milliseconds or five 
minutes), another piece of 
information is sent called a Note 
Off message, which simply tells 
the synth plug-in that it should 
stop playing that note.

As we said before, all of this 
stuff happens behind the scenes, 
and when recording MIDI into a 
computer, you’ll just see one note 
on the screen, with clear start and 
end points, rather than two 
separate messages for Note On 
and Note Off.

So, if you’re playing a part 
requiring a range of different note 
lengths, such as a synth lead, 
you’ll soon see why the Note Off 
message is important. Drum 
sounds, on the other hand, don’t 
generally need Note Off 
messages – after all, you can’t 
hold a snare drum sound.

Velocity

Velocity is a measure of how hard 
a note has been played on your 
MIDI keyboard – with the vast 
majority of sound generators, 
such as samplers and most preset 
synth patches, you’ll find that this 
directly corresponds to how loud 
the note sounds. 

What’s more, with many synth 
and sampler patches, velocity 
affects the actual sound as well as 
the volume of the note depending 
on the velocity. This is most 
noticeable in those plug-ins and 
patches that are designed to 
replicate real instruments, which 
will usually be set up to sound 
different when they’re played 
hard to how they sound when 
played softly – just like the 
instruments they’re emulating. 

As with the majority of MIDI 
messages, Velocity ranges from 
1 for the quietest note to 127 for 
the loudest. This range is 
actually common to all MIDI 
messages that aren’t just Note 
On or Note Off.

For obvious reasons, Velocity 
messages are crucial for 
recording an expressive MIDI 
performance and replicating real 
instruments with wide dynamic 
range and a variety of timbres.

Other messages

As we’ve hinted at in the Velocity 
column, MIDI isn’t just about 
notes – there are a range of other 
things that can be done with the 
protocol, and, in fact, anything 
you do on a MIDI device will be 
sent out as a MIDI message, 
including moving any of those 
faders and knobs that most MIDI 
controller keyboards come 
equipped with.

Most of these other messages 
will be MIDI Continuous 
Controller messages (also known 
as MIDI CCs), which can be used 
to control all manner of software 
parameters, from a plug-in synth’s 
filter cutoff frequency to a DAW 
mixer’s level faders.

Many MIDI CCs are set to 
standardised values across all 
products. The modulation wheel 
on any MIDI keyboard, for 
example, sends out MIDI CC 
number 1, while your sustain 
pedal undoubtedly transmits CC 
64. Once again, you don’t actually 
need to memorise these CC 
numbers: the computer will just 
do it for you; and as mentioned 
earlier, MIDI CC’s have a range of 1 
to 127, to be translated by the 
software as appropriate to the 
parameter being controlled.

MIDI channels

Finally, it’s also worth noting that 
MIDI devices have 16 MIDI 
‘channels’ available to them. 
These channels enable, for 
example, a sequencer to output 
different parts to different sounds 
at the same time, or a keyboard to 
trigger different patches in a 
multi-timbral instrument (simply, 
a synth or sampler with several 
patches loaded at once).

MIDI channels used to be a 
vital consideration in electronic 
music production, although they 
aren’t used much at all nowadays. 
This is because music software 
does away with the limitations of 
old hardware that made 
multi-channel MIDI necessary. 
However, you may still need it in 
when using the aforementioned 
multi-timbral instruments, such 
as an orchestral ROMpler plug-in, 
for example.

Multi-timbral instruments such as IK 
Multimedia’s Philharmonik still require 
the use of separate MIDI channels
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POWER TIP

>Loud and clear
By audio output, we simply mean 
something you can hear. Dedicated 
MIDI tracks only deal with MIDI 
data, which you then have to send 
out to another track with a sound 
module loaded before you can hear 
anything. Instrument tracks pack 
these two into one so you don’t 
have to worry about routing. Most 
modern software packages feature 
instrument tracks, although a few 
still only use the ‘two separate 
tracks’ method. See the MIDI 
routing boxout for more on this.
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 > Step by step   Using a piano roll editor to draw in a MIDI pattern 

Let’s create a basic drum beat with 
MIDI. We’ll program a groove using a 

piano roll editor, then send the notes to a 
sampler plug-in with a drum kit patch 
loaded. A piano roll editor is a way of 
representing music onscreen and you’ll 
find yourself using one for most of your 
MIDI-involved time. We’re using the one in 
Logic Pro, but they all work in much the 
same way, no matter which DAW you use.

1
In Logic Pro, go to File»New…, then 
select Empty Project from the 

Explore collection. You’ll be greeted 
with a dialog asking what tracks you want. 
The default is one software instrument 
track – click Create. This software 
instrument track type combines MIDI 
input with audio output.

2

For a sound source (the device that’s 
going to read our MIDI data and give 

us some music from it), we’re going to use 
Logic’s EXS24 sampler. To load up this 
plug-in, click and hold the box just below 
the I/O label in the mixer section on the 
left, then choose Stereo under the EXS24 
(Sampler) submenu.

3
With EXS24 loaded, we can choose a 
drum kit patch. You can load up any kit 

you like (Logic ships with a few of its own), 
but we’re going to use a Garageband 
patch. Click and hold the three green 
dashes in the display on the central panel 
to bring up the list, navigate down to 
Garageband, then select Hip Hop Kit. 
Now close the EXS24 window.

4
Most music applications work with 
data objects called ‘regions’ or ‘clips’. 

These are visual ‘containers’ for MIDI and 
audio that enable you to see where 
everything is in your track. They also 
make it easier to drag grouped sets of 
notes around. In Logic, create one by 
right-clicking the empty space 
underneath bar 1 in the Inst 1 track, and 
selecting Create Empty MIDI Region.

5

Double-clicking the new region will 
bring up the piano roll editor. A piano 

roll is a simple chart of notes against time, 
with a piano keyboard displayed up the 
side, and bars and beats along the top. 
You’ll notice that the notes on the piano 
are numbered: middle C is called C4, 
because it’s the fourth C up on a standard 
88-key keyboard.

6
In the top-right of Logic Pro’s piano roll 
window are the tools: two boxes, one 

of which will probably be a pointer, the 
other a pencil. If they aren’t, click and hold 
each one and select a pointer for the left 
box and a pencil for the right. The box on 
the left is the tool used when you click, 
whereas the tool on the right is the tool 
used when you Cmnd-click.

7
Try clicking the notes on the piano 
keyboard on the left-hand side – the 

different notes trigger different drum 
sounds. You’ll notice that the note lanes 
are shaded differently: white note lanes 
are a slightly lighter grey than black note 
lanes. Let’s click some notes in. Scroll 
down until you get to C1 and click the 
piano key. This is a kick drum on almost all 
drum kit patches.
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MIDI routing
In the walkthrough, we briefly 
discussed instrument tracks and 
how they negate the need for 
separate MIDI and audio tracks, 
inputting MIDI and outputting 
sound by combining the two in one 
place. However, some DAWs don’t 
feature dedicated software 
instrument tracks, meaning you 
need to create a MIDI track onto 
which all your MIDI data is recorded, 
then create a separate type of track 
(often labelled an Auxiliary track) to 
house your sound source (be it a 
plug-in synth, sampler or whatever). 
To link the two together, you have to 
either route the MIDI output of the 
MIDI track to the MIDI input of the 
Auxiliary, or tell the Auxiliary to 
take its MIDI data from your MIDI 
track. The actual process of doing 
either of these is pretty simple – in 
most software DAWs, the settings 
for a track’s inputs and outputs are 
located just above the fader and pan 
controls on its mixer channel strip.

If your music software enables 
you to tell a sound source where to 
take its MIDI input from, this affords 
you some interesting routing 
possibilities. For example, you could 
tell two different synths to both play 
the notes from the same MIDI track 
to create a layered sound.

MIDI routing is easier to 
understand if you try to picture it in 
physical terms, just as was literally 
done in the days of hardware, when 
synths and samplers were physical 
boxes rather than software plug-ins. 
Separate bits of MIDI hardware 
need to be connected together with 
MIDI cables. For example, a MIDI 
controller keyboard is simply for 
playing notes and contains no 
sound generator of its own. To get 
some noise out of it, you have to 
take a cable from its MIDI Out port 
and plug it into the MIDI In port of a 
synthesiser. With a MIDI splitter 
cable, you can even take a MIDI 
output and plug it into two different 
synth modules, just like the 
software example cited above.

Once upon a time, MIDI meant MIDI cables – 
lots and lots of MIDI cables. These days, it’s 
all done virtually, in software

To add a note, hold down the Cmnd 
key and click the C1 lane at bar 1, beat 

1. Don’t worry about the note’s duration. 
Carry on and create a whole drum groove 
by Cmnd-clicking notes in: you’ll probably 
find the snare on D1 and the hi-hat on F1.

9
When you press play, you’ll hear your 
groove. The software is sending the 

notes to the EXS24 as they occur, and the 
EXS24 is outputting the sounds assigned 
to the notes within it as it receives them. 
Remember: with the vast majority of drum 
samplers, it doesn’t matter how long the 
notes are, as the Note Off message that’s 
sent at the end of the note is ignored.

10

Of course, we haven’t changed the 
velocities of any of our notes yet – 

they’re all set at the default value. To do 
so, you can use the velocity tool (click and 
hold a toolbox in the top-right to select 
this). Click and hold a note with it, then 
drag up or down to change its velocity.

11
Let’s try another instrument – one with 
which the Note Off message comes 

into play. Create a new Instrument track 
by clicking the + button above the track 
list, and load up Logic’s electric piano 
plug-in, the EVP88. Create an empty MIDI 
region as before, then double-click it to 
open the piano roll editor.

12

This time when you’re adding notes, 
try clicking the right-hand edge of one 

and dragging it to the right – the note will 
become longer. When you play your track 
back, the note will be held down until the 
end of the rectangle you’ve just drawn. 
Logic sends a Note Off message at this 
point, cancelling the held note.

13

 > Step by step   Using a piano roll editor (Continued)                              

POWER TIP

>Duly noted
To the right of Logic’s piano roll is 
the Event List (Select Window» 
Event List if it’s not there). This is a 
numerical display of every event 
that occurs – in this case, it’s simply 
a list of what notes are played and 
when, their velocity (the Val 
column) and their length. You’ll 
notice a lack of Note Off messages 
because Note On/Off is kept 
hidden for simplicity). The Event 
List is useful because you can click 
and hold on values, then drag up 
and down to alter them, giving you 
a very fine degree of control.
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POWER TIP

>Out of time?
Be careful when using quantisation. 
Larger note length values will give 
more drastically quantised results. 
As useful a tool as it is, quantisation 
can suck the life out of your playing 
and make it sound too rigid – being 
in time is good, but humans aren’t 
machines and very slight timing 
imperfections aren’t always a bad 
thing. Because quantisation affects 
the whole selected region, it may 
be wiser to correct any dodgy 
notes manually by dragging them 
left or right, especially if you’ve 
only played a couple out of time. 
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 > Step by step   Using a MIDI keyboard 

Using a MIDI keyboard to control 
your music software is easy and fun. 

First, of course, you’re going to need a 
MIDI keyboard. You can get a decent 
one for well under £100 and to help you 
out, there’s some buying advice on the 
next page. We’re using an E-MU Xboard 
49 here, which is a basic four-octave 
USB model.

1
So what’s it got to do with USB? Well, 
MIDI devices normally use MIDI cables 

to talk to each other – leads that can only 
send data one way, meaning that if you 
wanted to do something more advanced, 
you’d need two cables to enable two 
devices to communicate in both 
directions. Nowadays, most MIDI 
keyboards send their MIDI data over USB, 
which is much simpler. Let’s plug in.

2
If you’re using Windows, the operating 
system should automatically look for 

the correct keyboard drivers when you 
first plug it in. If it doesn’t, consult your 
keyboard’s manual. OS X should also 
install your keyboard – probably invisibly. 
Load your music software – we’re using 
GarageBand ’09. If you’re a Windows user 
or don’t have GarageBand, you’ll find most 
music apps treat keyboards the same way.

3

With Garageband loaded, select New 
Project and Piano. Once you’ve 

chosen a location for your song, you’ll 
have an empty session to play with – save 
for one Piano track. The Piano track here is 
like the instrument tracks we saw in the 
previous tutorial – it handles MIDI data on 
the way in, but outputs audio straight to 
the master channel and your speakers.

4
Now let’s get some sound out of the 
piano. If it’s not active already, click the 

little grey circle (the record arm button) 
just to the right of the piano icon. When 
you play your keyboard now, it should 
work just like a real piano! Record some 
MIDI by clicking the Record button on the 
transport bar at the bottom. Note that you 
can turn off the metronome by holding 
down the Cmnd key and pressing U.

5
As you record your MIDI data, you’ll 
see a region develop on the timeline. 

Double-click this region to bring up the 
piano roll editor, where you’ll see all the 
MIDI notes you recorded: their positions, 
their lengths and their velocities. Click and 
hold the View menu in the piano roll to 
see any other playing information the 
computer recorded, including sustain 
pedal and pitchbend wheel movements.

6

Because it’s MIDI data, you can drag 
notes around wherever you like. This 

is useful for correcting mistakes. You can 
also change the sound. Bring up the track 
info sidebar by clicking the i button (the 
middle one of the three at the bottom 
right). Now you can change the sound by 
simply selecting a different instrument.

7
You can improve the timing of any 
sloppily-played notes by snapping all 

notes recorded to the nearest of a 
specified time division. This is called 
quantisation, although GarageBand calls it 
Enhance Timing. It couldn’t be simpler – 
you just select a time division in the menu 
in the piano roll editor. GarageBand also 
provides a slider for determining how 
much quantise to apply.

8



While clicking notes into a piano roll editor 
will get the job of MIDI input done, it isn’t as 
spontaneous, creative and fun as using a real 
instrument. MIDI controller keyboards have 
no sounds of their own – they’re designed to 
output MIDI data for the software on your 
computer to turn into sound.

There are a wide variety of MIDI 
keyboards on the market, across a broad 
range of specs, sizes and prices. Luckily, you 
can get one featuring all the knobs and 
faders you might need for well under £100.

The first thing to consider is size – ie, the 
number of keys. The shortest keyboards only 
have 25 keys (two octaves), but this should 
be more than enough if you’re only going to 
be playing in basslines, synth leads and drum 
beats. Remember – you can always use the 
octave shift keys on your keyboard on-the-fly 
to access a wider register (range of note 

pitches). Such a portable instrument may 
prove useful for live use, too. A great example 
is the M-Audio Oxygen 8, which has eight 
knobs and a street price of around £80.

Going further down the portability route, 
new ‘nano’-sized keyboard have found 
favour with laptop musicians, with smaller 
keys to give an ultra-small footprint. Korg’s 
nanoKey and Akai’s LPK25 cost around £45.

Of course, you can always go for a full-on, 
88-key MIDI controller if you’re a trained 
piano player. M-Audio’s Keystation 88 ES is 

around £150 and packs 88 keys, although it 
doesn’t feature any rotary controls or faders, 
and the keys are semi-weighted, meaning 
they respond similarly to a piano. If you want 
hammer action keys (which get you even 
closer to the feel of a real piano), you’re going 
to have to fork out a bit more still. CME’s 
UF80 is around £400, but also packs eight 
faders, eight rotaries and an aluminium body.

You should also check whether or not the 
keys output velocity data. Some smaller 
keyboards don’t and are thus worth avoiding.

Buying a MIDI controller keyboard

The CME UF80 might be expensive, but it packs a huge array of useful  control features
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 > Step by step   Taking control with knobs and faders 

The knobs and faders on your MIDI 
keyboard or dedicated MIDI controller 

unit offer a level of tactile real-time control 
that you just don’t get using a mouse to 
adjust effect parameters. We’re using 
Ableton Live here, but all DAWs offer the 
same kind of external MIDI control.

1
The controller keyboard we’re using, 
the E-MU Xboard 49, features a bank 

of rotary controls that we’re going to use 
to control an effect. Most modern 
keyboards have at least a couple of these 
knobs onboard: check the boxout for 
some keyboard buying advice.

2
With the keyboard hooked up via USB, 
we load Live’s MIDI preferences pane 

(go to Preferences»MIDI Sync) to set up 
our MIDI input. Live has automatically 
recognised the keyboard here, so we can 
close the MIDI preferences. If your 
keyboard isn’t visible, just select it from 
the MIDI Input drop-down menu and 
activate the Remote button.

3

Now we need some audio to process 
with our effect. Simply drag any audio 

file from the Library on the left onto a new 
audio track. Now we can load up our effect 
– we’re going to create a basic low-pass 
filter sweep (you’ll recognise the effect 
when you hear it), so drag Live’s Auto 
Filter plug-in in from the Devices pane.

4
Next, we need to link our rotary 
control to the effect. To do so, click the 

MIDI button at the top-right of the screen 
to go into MIDI learn mode. All of Live’s 
MIDI-controllable parameters will go 
purple. Click the desired parameter (in this 
case, the Auto Filter’s Cutoff control). 
Finally, deactivate MIDI learn mode by 
clicking the MIDI button again.

5
With MIDI learn mode still enabled, 
twiddle the knob on your keyboard 

that you want to assign to the Cutoff. And 
that’s it! Your rotary control will now 
control the filter cutoff in real time. And 
remember: because MIDI captures every 
single performance detail, you can 
record your real-time effect tweaking and 
edit it afterwards.

6



POWER TIP

>Snap to it
Moving, splitting, adjusting the 
start and end boundaries of a 
region, and, in fact, most other 
editing functions are helped along 
by snapping. Snapping assumes 
that you normally want to edit to 
the nearest bar or beat rather than 
an arbitrary point along the 
timeline, making editing a far less 
fiddly process. In Logic, you can 
adjust the division that snapping 
jumps to in the Snap menu, or edit 
with more precision by clicking and 
holding, then holding down Ctrl 
(or Ctrl+Shift if you want to get 
really intricate).
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 > Step by step   Working with MIDI regions 

If you’ve followed our piano roll editor 
walkthrough, you’ll already be familiar 

with regions – the containers that music 
applications use to organise MIDI data. 
Knowing how to work with regions is 
crucial to building a MIDI-led track, so 
we’re going to look at them here in more 
depth. We’re using Logic Pro again, but 
region functionality is essentially the 
same in all apps.

1
Let’s say you’ve created a one-bar 
drum beat and you want to expand it 

into a two-bar groove. Simply click and 
drag the bottom-right corner of the region 
to the right, until you get a two-bar region, 
then double-click it to edit it in the piano 
roll window. In the piano roll, copy 
your notes across by dragging a box 
around them, and Alt-dragging to the 
desired location.

2
This Alt-drag functionality also works 
with whole regions. Let’s try it in Logic 

Pro – go back to the main sequencer 
window and Alt-drag your region to the 
right, until you get two regions. You can 
then drag a box around the two regions 
and Alt-drag those so that you have four 
regions, then Alt-drag those until you 
have eight…

3

Rather than forever Alt-dragging, 
though, you can repeat a region a set 

number of times by Ctrl-clicking it, 
selecting Edit»Repeat Regions…, then 
entering the number of repetitions you 
want. This is an easy way to get a drum 
beat rolling throughout your entire song, 
for example.

4
If you repeat a region, each copy 
exists independently of the others. So, 

if you edit the drum beat in the bar 1 
region, you’ll have to repeat the region 
again to change the whole song. But if you 
click and drag the top-right corner of a 
region in Logic Pro, you can loop it a set 
number of times, meaning that any 
changes in the looped region will also 
affect its copies. 

5
These repeat and loop functions work 
across multiple tracks, too. This makes 

it easy to change the length of an entire 
section with just a few mouse clicks. 
Simply drag a box around the regions you 
want to repeat to select them, then either 
right-click and choose Repeat Regions… 
or drag the top-right corner as before. Of 
course, good ol’ copy and paste will work 
just as well, too.

6

With all these repeated regions 
knocking about, it can sometimes 

make things easier to merge MIDI data 
across multiple regions into one large 
region. To do this, select your Glue tool, 
select the region at the start of where you 
want to merge, then Shift-click the region 
at the end.

7
You can also split large regions into 
sections. Simply select the Scissors 

tool, then click the region at the point you 
want to cut it. You’ll be left with two MIDI 
regions. Bear in mind that these will 
sometimes overlap if you’ve tried to split a 
long note – rather than cut a note in half to 
create two smaller ones, Logic usually 
splits the region after the note finishes.
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Humanising 
tips
INSTRUMENTAL
Key to getting a human-sounding 
part is thinking like an 
instrumentalist would. Being able to 
play it helps immensely, but if you 
can’t, try to at least get a basic 
knowledge of how it’s played.

EASY DOES IT
Don’t overdo it! The human ear is 
incredibly sensitive to volume 
changes and even more sensitive to 
timing. You only need to make tiny 
tweaks to drastically improve the 
feel of your music.

AUTO PILOT
Don’t overuse automatic humanise 
functions. They’re simply 
randomising functions to add 
imperfection – they don’t emulate 
the feel that a real player has. Be 
careful not to let them wreck your 
painstakingly tweaked parts right 
at the end, either.

BLOCK PARTY
Block chords on keyboard parts 
often sound too… well, blocky. 
Spreading the note timings very 
slightly can help soften them up.

SPOT ON
Be aware of flams. Flam is a 
drumming word for when two notes 
are played at almost (but not quite) 
the same time. Having your hi-hat 
occur slightly after a snare, for 
example, doesn’t sound human – it 
just sounds sloppy. Try to get any 
drum hits that occur on top of each 
other to be pretty much dead on.

TERMINAL VELOCITY
Velocity levels can be used by 
samplers to change sounds 
depending on how hard the note is 
played. This helps to make things 
more realistic, but because there’s 
sometimes a hard jump between 
one velocity level and another, a 
note with a velocity of 88 may 
sound very different from one of 89. 
Use your ears and listen carefully 
for notes that seem to ‘jump out’ 
where you don’t want them to.

MAKE A CHANGE
If using a humanise tool, apply it to a 
long section, rather than one bar 
that will then repeat. This will give 
more variation, as every bar will be 
different from the last.

DRUM MACHINE
Don’t humanise everything. 
Whether you need to make a part 
human or not depends on the genre 
– you wouldn’t do it to an electro 
pop drum track, for example.

One of the great things about MIDI is 
that you can program parts for 

instruments that you might not be able to 
play yourself. But parts that are drawn in 
or quantised can sound overly rigid or 
robotic. It’s easy to get things sounding 
realistic, though. We’re using Logic Pro 
here, but there are similar functions in 
most other DAWs.

1
Drum parts are the worst offenders 
when it comes to rigidity. Here we’re 

working on a standard 4/4 rock drum 
pattern, featuring a constant 8th-note 
hi-hat pattern. You’ll find a MIDI pattern 
(Rigid-Drum-Beat-Raw-MIDI.mid) on the 
DVD in Tutorial Files/The Beginners’ 
Guide to MIDI, which you should load 
onto an instrument track with a drum kit 
sound loaded by choosing File»Import.

2

When it comes to humanising, we 
have three things to play with: how in 

time (early or late) each note is, how long 
each note is held for (not relevant for 
drums, of course) and how loud each note 
is (velocity). Let’s kick off by reducing 
every other hi-hat’s velocity from 80 to 
40, to give the track some bounce.

3
Already our drum part sounds more 
human. Let’s go further with velocity 

editing to make the snare drums and the 
kick on beat 1 louder (set the velocity to 
90) and the second kick drum (the offbeat 
one) quieter (velocity of 50). Our drum 
track is now sounding more like how a real 
drummer would probably play it.

4

No human drummer has perfect  
timing, so a snapped-to-beat MIDI 

drum part can sound too robotic. We’re 
going for a lazy hip-hop vibe here, so let’s 
make every other hi-hat (same ones as 
last time) a bit late to add a touch of swing. 
Select all four, click and hold on them, then 
hold Ctrl to override snapping and drag to 
the right a couple of pixels. Do the same 
with the offbeat kick drum.

5

 > Step by step   Humanising MIDI for ‘realism’ 

POWER TIP

>Random factor
Logic has a built-in humaniser 
that works by randomising timing, 
velocity and note length. Select all 
the notes you want to affect in the 
piano roll window, then click 
Functions»Transform»
Humanize. We’re going to 
randomise both note position and 
velocity here – we’re happy with a 
level of 10 for each, so select 
Operate Only. Et voilà! A much 
more realistic part. Compare 
Drum-Part-Rigid.aif with Drum-
Part-Finished.aif on the DVD and 
judge the results for yourself.
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POWER TIP

>In the groove
Reason’s ReGroove mixer is special 
– most programs only enable you 
to apply a groove template to a 
MIDI part as an edit, meaning once 
you’ve applied it, it physically 
moves the notes and changes their 
velocities. The ReGroove mixer, 
however, works in real time. You 
can drag the fader up and down to 
tweak how much the groove 
template affects the MIDI part and, 
if you change your mind, simply 
unassign the MIDI channel in 
question and the MIDI region will 
be just as it was to start with.
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 > Step by step   Using groove templates 

Here’s an easy way to add feel to your 
MIDI parts. We’re using Reason 4 here, 

but most music apps can apply groove 
templates to MIDI parts. A groove 
template is a MIDI file that’s used to affect 
another piece of MIDI data. The computer 
looks at the groove template’s swing, 
bounce and general feel, and applies it to a 
drum beat or other MIDI part without 
changing the notes themselves.

1
Create a new song, then go to 
Window»Detach Sequencer 

Window to separate the rack (where our 
sound modules are housed) and the 
sequencer (where our MIDI data will be, 
once we’ve programmed some). Now load 
Reason’s drum machine, Redrum, by 
right-clicking the empty area of the rack 
and selecting Redrum Drum Computer.

2
Let’s load a sound. Click the Open icon 
at the bottom left of Redrum, then 

select Reason Factory Sound Bank on 
the left. Open Redrum Drum Kits, then 
navigate to Hip Hop Kit 02.drp. Redrum 
loads the sounds into its ten channels – 
audition them by clicking the play button 
at the top of each channel. You’ll notice 
that each channel now contains a different 
drum or cymbal.

3

Redrum features a step sequencer. 
The line of 16 buttons at the bottom is 

where you program in your notes – the 16 
‘steps’ each last for one 16th-note by 
default. The step sequencer section 
applies to the currently selected channel. 
At the moment, channel 1, with a kick 
drum sample loaded, is selected. Program 
a kick drum groove, by clicking steps 1, 2, 
4, 7 and 8. Hit Run to hear it.

4
Let’s slow the tempo down to a 
relaxed hip-hop speed by setting the 

Tempo control at the bottom of the 
sequencer window to 74. Now we’ll finish 
our groove – add the kick drum from 
channel 2 (click Select at the bottom of 
channel 2) to steps 10 and 14, the snare 
from channel 3 to steps 5 and 13, and the 
hi-hat from channel 10 to every step. Now, 
that’s more like it!

5

Let’s convert Redrum’s step 
sequencer groove into MIDI data. This 

is easy – just right-click Redrum and select 
Copy Pattern To Track. Deselect Enable 
Pattern Section, too, so the two parts 
don’t play at the same time. Now go to the 
sequencer window – you’ll notice some 
regions in between the left and right loop 
markers on the timeline. Play the track – 
your groove is now playing from MIDI.

6
Click the ReGroove Mixer button at 
the bottom right. The ReGroove Mixer 

features four banks of eight channels, 
each of which can contain a different 
groove template. Let’s load one into A1: 
Click the Open button, then browse to 
ReGroove Patches/ Drummer/Vintage 
Soul-RnB/Personality. Assign your 
Redrum channel to A1 using the menu to 
the left of the sequencer window.

7
Raise the A1 fader – the higher it goes, 
the more swing it adds. For subtlety, 

we’re only bringing the fader up to 40%. 
When you get more advanced, you can 
apply different groove templates to 
different instruments – just use your ears 
to make sure it all gels. Check out the Tool 
window, too – here you can adjust how 
much note velocity is affected by the 
groove template, among other things.
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 > Step by step   Arpeggiators and other MIDI effects 

Effects aren’t just for audio – you can 
get MIDI effects, too. For example, let’s 

look at the arpeggiator, a feature found on 
quite a few hardware synths that’s found 
its way into software. Arpeggiators spread 
or repeat the chord or note you’re playing, 
creating an arpeggio. We’re using 
Cakewalk Sonar here.

1
With an empty session loaded in 
Sonar, create an instrument track by 

going to Insert»Soft Synths. Then choose 
an instrument – we’re going for True 
Piano. In the next dialog box, leave 
Simple Instrument Track selected and 
click OK.

2
Click the Maximise Strip icon at the 
top right and make sure the All tab at 

the bottom is highlighted. Now choose 
your MIDI keyboard from the MIDI input 
drop-down menu (select MIDI Omni), and 
you should be able to play the piano. (Go 
to Options»MIDI Devices… if your MIDI 
keyboard isn’t showing up).

3

Notice the Arpeggiator label on the 
right of the track controls? Click the 

little box to the left of the text and it’ll turn 
green – this engages the effect. Now click 
the arrow on the right – this will give you 
access to all its options. Try holding a note 
or two now and listen to your arpeggiator 
in action!

4
Have a play with the options until you 
get the effect you want. You can adjust 

the repeat rate, the octave range, the 
order in which the notes within a chord 
are played and more. Now hit record and 
see what happens when you play some 
notes in.

5
You’ll notice that the MIDI region is 
only showing the notes you played in 

and not the arpeggiated notes. This 
means you can change the settings of 
the arpeggiator, or even turn it off 
completely after you’ve recorded your 
triggering part.

6

The arpeggiator is a creative, fun tool that can 
really add some spark to your MIDI parts, but 
Sonar has other MIDI plug-ins, too, such as MIDI 
Echo Delay, which repeats the notes you play, 
much like an audio delay plug-in. Others are 
more pragmatic: the chord analyser can help 
you out if music theory isn’t your forte; there’s a 
MIDI event filter, which acts like a type of gate to 
only let certain MIDI events through; and Sonar 
has transpose and velocity-based tools, too.

Ableton Live also has powerful MIDI plug-ins 
built in, including Scale, which enables you to 
constrain your played notes to a musical scale, a 
randomiser, an octaver effect (which duplicates 
your notes an octave above where you play 
them) and more.

MIDI plug-ins are useful in a recording 
environment, but it’s when using them live that 
they really come into their own. Arpeggiators, 

for example, make it 
possible to play 
complex-sounding 
parts by just holding 
down a chord with one 
hand, leaving your 
other hand free to 
adjust rotary controls 
or tweak mixer settings. And because MIDI 
effects don’t have to process audio, they don’t 
use up much CPU power, leaving your processor 
free to deal with more complicated tasks.

Grand designs
If you like the idea of using MIDI when you play 
live, you might want to check out a MIDI plug-in 
by Sugar Bytes called Thesys. It packs numerous 
features that you probably won’t find in your 
standard music app. As well as being able to 

handle simple arpeggios, you can also program 
complex note sequences, controller changes 
(sent out to an audio plug-in such as a filter), 
pitchbends and more, which all then shift 
around depending on what note you play.

There’s even software that enables you 
create your own MIDI effects. Cycling ’74 
Max/MSP isn’t for beginners (in fact, it’s more 
like a programming language than a music app – 
albeit a fun one), but with a bit of work, you can 
get make mind-blowing things with it. 

More MIDI effects

“Because MIDI effects don’t have 
to process audio, they don’t use 
up much CPU power”


